
Sardar kaurey Khan Public Higher Secondary School 

Muzaffargarh. 

Syllabus/Notes September 2020 

 Subject: English                    Teacher :Ms Farhat Gul      Class: 8th 

English A  Poem children understand him: Reading(two times) word 

meaning, Ex.A (2),B(1,2,),C (1,2)  Reading comprehension of the given Passage. 

English B Scientific Grammar part III Ch# 1 The Parts of speech: Pronoun . 

pg#25 Exercises (i, ii, iii) pg 29 Exercises( i, ii iii, iv, v)Uses of Tenses Exercises 

pg( 51 to 56 ) .Translation urdu to English  Proverbs and Exercises pg # 31 ,32, 

43,50, 51 ,( From Scientific Grammar) Active voice passive voice ( revision of 

all tenses)  

 Note: Do reading of the textual units and underline / highlight all the new 

words and learn their meanings and spellings. 

Poem: Children Understand Him : words meanings (learn from book) 

Q Answer the following questions with reference to context. 

a:   And only this has kept intact 

       His pride and self -respect. 

i: What does “intact” mean? 

Ans: Intact means Secure.Here it means that the old man still has secured 

some pride and self respect. 

ii: What has kept his pride and self – respect intact? 

Ans: His affection for children has kept his pride and self- respect intact. 

iii:What metaphor is used to describe what he might have been without this 

? 

Ans : The metaphor a dry stream-bed is used to describe what he might have 

been without this 

b: They sail to the harbour of his knees 
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i: Who are they ?  

Ans: They are grand children 

 ii: When do they sail to his knees and why ? 

Ans: They sail to the harbour of his knees when they play with him. 

iii: Which words or expressions are used metaphorically here ? 

Ans : The phrase “sail to the harbour of his knees  is used metaphorically. 

ExB(1)Pg# 60  Make sentences 

1: Again and again ( repeatedly) :We should try again and again till we 

succeed. 

2:On and on (continuously ):The rain went on and on last night 

3: Far and wide ( covering large area ):His fame spread far and wide. 

4: Round and round (moving in circle):  The children were spinning round and    

round. 

5: In and out(staying for a short time) The students were in and out of the 

library. 

6: To and fro (moving back and forth) The lion was moving to and fro in the 

cage. 

7: By and by (after a while) The match will be over by and by. 

8: Far and away (extremely)He is far and away the best player in our team. 

9: Over and over (repeatedly)  Don’t say the same things over and over. 

10:Here and there (at various places) Don’t waste your time by sitting here 

and        there. 

11: Off and n (now and then) He comes here off and on. 

12: Now and again (from time to time) We visit the library now and again. 
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13:By and large (generally) Poverty is by and large the biggest problem of 

India. 

14: Out and out (thoroughly,completely) He is out and out a gentleman. 

15 : First and formost (above everything) Our first and foremost duty is to 

respect our parents. 

16: Through and through (completely) I know her through and through. 

17: More or less (approximately) There are more or less five thousand books 

in our library. 

18: Up and about (recover) My friend was up and about from COVID19. 

Ex.B (2) What name do we give to each type of person described below. 

Learn examples as well 

1: Hypocrite  2: Herbalist 3:Optimist  4: Widow  5: Widower 6: Donor 

7:Bachelor 

 8: Pilgrim  9: Genius 10 :Pessimist. 

Ex .C :(1)pg 62 May/Might 

A:May expresses: 

 i:Probability or possibility    

 ii:  permission (Polite) 

 iii:  wishes (for others)   

B: Might expresses:      

 i: a weak possibility (Perhaps) 

ii: a polite suggestion  

iii :the past tense of may ( in indirect speech ) 

Ans :Fill in the blanks  

a ):  may  b):might   c ): May  d ): Might  e): may  f): may  g): May.  
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Ex. C(2) pg 62 Reconstruct the following pair of sentences, so that they 

become one , with an adjective clause, introduced by  which, who, that, or 

whose. 

Ans : a : The children who were like tiny dolls came to school. 

b : The guests brought presents which made us very happy.  

c : My friend who was bitten by a mouse jumped up and down. 

d : My father who was a doctor and a surgeon worked in the poorest areas of 

the city  

e :I watched the moon which was bathing the earth with its light and rising 

high into the sky. 

f : The children sat around the teacher whose bag was full of colourful pens. 
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English B 

Active voice Passive voice:  (Revision all tenses) 

Steps: 

1: Underline the given verb and guess the tense. 

2:Replace the subject and object while changing  from active to passive. 

3:use relevant helping form of “be” +3rd form of verb. 

4:put by before new object. 

Be: is /am/ are ------------ (present) 

       Was /were ------------ ( past) 

        Been ------------------- (perfect tense ). 

A poem (is/composed )……………… Present. 

A poem (was/composed )………….. Past. 

A poem( will be /composed) ………… Future. 

A poem is( being / composed) ………….. Present Continuous. 

A poem was (being/composed) ……………… Past Continuous. 

A poem (has been/ composed)……………… present Perfect. 

A poem (had been/ composed)……………..Past Perfect  

 A poem (will have been/composed) ………….. Future Perfect 

 

Imperative sentences: (Let + Object + be + a.v3 

Love your parents.   >>>>>>>> Let your parents be loved 

Do not mark this paper. >>>>> Let this paper not be marked 

Use of Who:  Who will be changed into by whom in passive sentences. 
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i.e; Who – Whose - whom 

Who attends the patients ?   >>>>>>      By whom are the patients attended ?    

Q change the following from active to passive. 

1: A cat killed a mouse.  

2: She sings a song. 

3:They caught the thief. 

 4:I shall write a letter.  

5:He is fly(ing )a kite.  

6: He has just posted the letter.  

7: you kept me waiting for an hour.  

8: He had not seen the lion before. 

9: He is do(ing) a difficult sum. 

10: I have bought a new house. 

11:Our team will win the match. 

12: Who has written this letter ? 

13: Has Aslam  chosen a book? 

14:He is watching us. 

15: Did he catch the noon train? 

16:The officer offered him a job. 

17: They know it. 

18: I told him a story. 

19: One should do one’s duty. 

20: Has she eaten any raw fruit ? 

8th - Sep - 6



21: They jeered at him 

22: We shall look into this matter.  

23:Bring me a chair. 

24: Do not leave this job. 

25:Post this letter just now. 

26: Please fetch a glass of milk. 

27: Please keep to the left. 

28: Do it.  

29 :Who will carry this bundle? 

30:We must listen to his words. 

31: love your parents. 

32: Do this work today. 

33:Call in the doctor. 

34: Who knocks at the door? 

35: Who has painted this wall? 

36: Who is speak(ing )the truth ? 

37:Who was knock(ing )at door ? 
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Sardar Kauray Khan Public HigherSecondary School 

MuzaffarGarh 

Science syllabus for the month of August 2020-21 

Class : 8th      subject:science 

month week dates Working 

days 

activities           Topics 

september 

2020 

1 31-05 6  Chapter:8 measurement of physical 

quantities. Reading and Explanation pg 

(113—122) 

2 7-12 6   Chapter:8  measurement of physical 

quantities  exercise short question 

3 14-19 6  Chapter:8 measurement of physical 

quantities. exercise long question  

4 21-26 6                           revision 

5 28-

03(oct) 

6                      SELF ASSESSMENT 
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Chapter no.8   MEASUREMENT OF PHYSICAL QUANTITIES  

Q. SHORT ANSWER 

1) Define a physical quantity. 

 The quantities that can be measured are called physical quantities. 

E.g. length, mass, time 

2) Define the term prefix?  

 The words or letters that are added before SI units are called prefix. 

e.g. mile (m),cent (c), kilo (k) etc. 

3) What is meter rule?  

A meter rule is one meter long graduated stick that is usually used to measure 

length of an object or distance between two points. It is actually divided in to 

100 equal parts and each part is equal to 1 centimeter. 

4) How many millimeters are there in one dm3?  

There are 1000 ml in one dm3 

5) How many seconds are there in one solar day? 

 In one solar day,there is 24 * 60 * 60 = 86400 s 

Descriptive answers 

1-What are SI units? 

The system of units recommended by scientist in an international conference 

held in Paris in 1960 is known as system international units abbreviated as “SI”. 

SI units of length, mass time are meter (m), kilogram (kg), second (s) 

respectively. 

2- Define the importance of SI unit. 

The main advantage of SI units is that their multiples and sub multiples can be 

conveniently expressed by using prefixes. Prefixes are based on multiplying 
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and dividing the units by power of 10. The SI unit is equally used in all over the 

world.  

3) The length of a wooden rod is 25.5 cm convert them into 

Millimeter  

As 1 cm =10mm  

So 25.25 cm = 25.5 * 10 mm  

= 255 mm 

Meter  

As 100cm =1m  

1cm = 1/ 100 then  

25.5 cm = 25.5 / 100  

              = 0.255 

4) The mass of iron plate is 1950g. What is its mass in kg?  

 The mass of iron plate in kg will be  

     1kg = 1000 g  

So          1950/ 1000 = 1.95Kg  

             1950g= 1.950kg 

5) Convertin minutes 

A) 3600 sec  

60sec = 1 min  

1sec = 1/ 60 min  

3600 sec = 3600 /60  

3600 = 60 min  
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B) 2 hour  

 1 hour = 60 min  

2 hour = 60*2  

2 hour = 120 min  

6) Describe the use of measuring cylinder  

MEASURING CYLINDER  

 A measuring cylinder is an instrument that is used to measure the volume of a 

liquid. It is made up of glass and transparent plastic. It has a scale in milliliter 

(ml) or cubic meter (cm3) along its length. That is why, it is also called 

graduated cylinder.  

RANGES  

Measuring cylinder   of different capacities (from 5 ml to 500 ml) is available in 

the   school laboratory.  

WAY OF TAKING MEASUREMENT 

 To measure the correct volume of liquid, cylinder must be placed on a 

horizontal surface and the eye should be kept at the level with the bottom of 

meniscus (curved surface) 
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 7) Write short notes on pipette and measuring flask  

MEASURING FLASK 

 flask are laboratory vessels.  They are made up of glass and plastic and are 

available in many shapes and sizes. In school laboratory they are usually 

available in the sizes of 50 ml, 100 ml, 500 ml and 1000 ml. they are graduated 

in the units of cubic centimeter (cm3) or millimeter (ml). 
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PIPETTE  

Pipette is commonly used in chemistry and biology laboratories to measure the 

volume of a liquid in small quantity. They are made up of glass and pipette   . 

They are available in the size of 10 ml to 25 ml  

 

 

 

MCQS 

 1) An electronic balance is used to measure  

a) Electric current                                          b) length  

c) Mass                                                             d) volume  

2) SI unit of mass is:  

a) Kilogram                                                        b) kilometer  

c) Pound                                                             c) ounce  

3) Which of the following liquid makes the meniscus opposite to the others?  

a) Mercury                                                         b) water  

c) Alcohol                                                           d) petrol  

4) Which of the following is the SI unit of volume?  

a) mb) m2 

c) m3                                                                       d) kg 
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(v) A mass of 2 kg is equal to: 

a) 1,000 g                                                                  b) 2,000 g 

c)2,500 g                                                                 d) 3,000 g 

(vi) Which of the following relation is correct relation? 

a) 1 min = 60 h                                                     b) 1m = 1,000 cm 

c) 1mL = 1 cm3                                                    d) 1min = 30 s 

(vii) A length of 50 mm is equal to: 

a) 0.5 m                                                                    b) 0.05 m 

c) 0.005 m d) 0.0005 m 

(viii) 25 cm3 is equal to: 

a) 25 mL                                                                                                     b) 2.5 mL 

c) 0.25 mL                                                                                                 d) 250 mL 

(ix) One kilometer is equal to: 

a) 100 m                                                                                                     b) 500 m 

c) 1,000 m                                                                                                   d) 10,000 m 

(x) Pipettes are commonly used for: 

a)Making solutions 

b)Measuring the volume 

c)Transferring a measured volume 

d)Measuring mass 
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Sardar Kaurey Khan Public Higher Secondary School Muzaffargarh 

 

Syllabus Breakup of 1st Term for the Month of September, 2020 

 

Subject: Social Studies Teacher: Kausar Parveen              Class: VIII   
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1 31-05 6  

Geography: Unit 5: Major 

Environmental Problems. Reading + 

Short Qs. 1, 2, 3 

2 7-12 6  

Unit 5: Short Qs. 4, 5. Detailed Qs. 

1,2,3,4,5. 

History: Unit 3: Political Awakening 

in British India. Reading 

3 14-19 6  
Unit 3: Ex. P. 34,35,36 on book. 

Short Qs. 1, 2, 3, 4, 5. 

4 21-26 6  
Unit 3: Exercise. Q6. Detailed Q5. (i 

- viii) 

5 
28-03 

Oct 
6  Revision + Self-Assessment 
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Sardar Kaurey Khan Public Higher Secondary School Muzaffargarh 

Notes for the month of September, 2020. 

Class: 8th         Subject: S.St. 

Geography 

 Chapter 5:  

Major Environmental Problems  

Exercise:  P.45 

Q1. Tick ( ) the Correct answer.     

(i). Noise pollution causes: 

a)weakness of eyesight   b)lungs problem. 

c)hepatitis     d) high blood pressure. 

(ii). Glaciers are melting due to: 

a) Soil pollution   b) Water pollution 

c) global warming   d) noise pollution 

(iii). __________ is made of different gases:  

a) lithosphere   b) hydrosphere  

c) atmosphere   d) biosphere 

(iv). Ozone layer is depleting due to:  

a) water pollution    b) soil pollution 

c) noise pollution    d) air pollution 

(v). Toxic gases enter the atmosphere due to: 

a) noise pollution   b) deforestation 

c) putting waste on fire  d) use chemical fertilizers 
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Q2. Give short answers.     Pg. 46 

Q i. What is meant by pollution? 

Ans:  Pollution means the negative changes in the natural environment due to 

the addition of harmful substances. These harmful substances, may be 

in the form of chemicals, noise, heat, dust or gas emission. 

Q ii. What is the cause of greenhouse effect? 

Ans: The cause of greenhouse effect is air pollution. CO2, methane, CFCs, dust 

particles and water vapors pollute the air which ultimately promotes the 

process of global warming resulting in greenhouse effect. 

Q iii. Name the types of pollution? 

Ans: The name of types of pollution are: 

1. Air pollution. 

2. Water pollution 

3. Soil pollution 

4. Noise pollution etc. 

Q iv. Give three strategies to reduce environmental pollution? 

Ans: Three strategies to reduce environmental pollution are: - 

1. Proper disposal of waste material.  

2. Cleanliness sense 

3. Promotion of green values in daily life. 

Q v. What is meant by global warming? 

Ans:  Global warming means when the natural forces have developed a 

protective gaseous envelop around the sphere of earth. The human 

activities are responsible for changing the structure and composition of 

this protective layer. The resultant gradual increase in terrestrial 

temperature as result of human interference in the natural environment 

is referred to as global warming. 

 

Q3. Give detailed answers.     Pg. 46 

Q i. Describe the causes and impacts of water pollution? 

Ans: Causes of water pollution: - 

The causes of water pollution are: 

1. Water is polluted when waste from homes and factories is released into 

lakes, rivers, seas, ponds, and oceans. 

2. Floods. 

3. Acid rain. 

4. Open dumping and disposal of solid waste in coastal areas. 
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5. The spoilage and leakage from marine traffic, hospital waste and 

industrialization. 

 

Impacts of water pollution: - 

The impacts of water pollution are: 

1. In polluted water of seas, rivers, lakes, ponds etc. the marine’s animals 

like fish, crab can’t survive. These animals take in this polluted water. 

When we eat these animals, the chemicals transfer into our bodies and 

cause diseases. 

2. Drinking contaminated water, can cause diseases like cholera, 

dysentery, hepatitis and typhoid. 

3. Polluted water is a breeding ground for mosquitoes. Mosquito bites can 

cause malaria and dengue. 

4. The water borne diseases are transmitted through plants and animals to 

human bodies due to biomagnifications. 

Q ii. Write the causes and impacts of soil pollution? 

Ans: The Causes of soil pollution. 

 Followings are the causes of soil pollution: - 

1. The major reasons for soil pollution include untreated domestic, 

industrial, commercial and hospital waste disposal. 

2. The careless use of chemical fertilizers, insecticides and herbicides in 

agriculture. 

3. Unplanned urbanization and careless constructional activities. 

4. The natural causes such as volcanism, earthquakes, soil erosion and 

desertification also contribute to soil pollution. 

Impacts of soil pollution: - 

The impacts of soil pollution are:  

1. The crops grown on contaminated land absorb much of contamination. It 

enters into human’s body when they eat them. 

2. Heaps of rubbish collected in open areas spoil the environment. 

3. The heaps of rubbish give bad smell and becoming the breeding grounds 

for mice, flies and mosquitoes and encourage diseases spread. 

4. Lungs infection, respiratory diseases, cancer and skin diseases. 

Q iii. Describe the causes and impacts of global warming? 

Ans: The causes of global warming: - 

 The causes of global warming are: - 
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1. Fossils, fuels also emit carbon dioxide which is a green house gas. It 

pollutes the atmosphere and contributes to global warming. 

2. Desertification, land and air pollution are the other main contributors of 

increasing the speed and scale of global warming in present times. 

 Impacts of global warming: - 

The impacts of global warming are:  

The global warming negatively impacts the natural environment by 

increasing the sea level, glacial melting, floods and droughts, and 

deforestation.  

Q iv. Explain the causes and impacts of air pollution? 

Ans: The Causes of air pollution. 

 The causes of air pollution are: - 

1. The smoke from cars, buses, trucks and vehicles, factories and power 

plants using fuel. 

2. The smoke produced by burning fossil, fuel such as coal, gas or oil. 

3. Marine traffic is considered as the main cause of air pollution in these 

days. 

4. Volcanism, wild forest fire storms and  tsunamis in the oceans, contribute 

in air pollution. 

Impacts of air pollution: - 

Followings are the impacts of air pollution: - 

1. Acid rains and the depletion of ozone layer are the result of air pollution. 

2. Many diseases like cataract, nose, throat, irritate the eyes, ear infection, 

headache, allergies and heart problems are caused by air pollution. 

3. The prevalence of cancer, liver, kidney and lungs diseases. 

4. Decline of agricultural production to polluted air. 

Q v. Describe the impacts of noise pollution? 

Ans: The impactsof noise pollution. 

 The impacts of noise pollution are: - 

1. Noise pollution affects both the health and behavior of people. 

2. It can cause high blood pressure, high stress levels and hearing loss. 

3. Sleeplessness, headaches and prevalence of psychological issues and 

social problems among the population are visible in the high-density 

areas. 
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History 

Chapter 3: 

Political Awakening in British India 

Exercise:  Pg. 21, 22 

Q1. Tick (      ) on Correct answer.       

I. Muslim League was established in:  

a. 1900    b. 1906 

c. 1910    d. 1916 

II. Who played important role in the Khilafat Movement? 

a) Quaid-e-Azam (R.A) b)  Sir Syed Ahmad Khan 

c) Maulana Zafar Ali Khan d) Maulana Muhammad Ali Juhar 

III. Indian national congress was established in 1885 in the city of_______? 

a) Delhi    b) Bombay 

c) Lahore   d) Calcutta 

IV. In which year partition of Bengal was annulled? 

 a) 1911    b) 1913 

 c) 1915    d) 1917 

V. Simla Deputation met whom? 

a) Lord Canning  b) Lord Curzon 

c) Lord Minto   d) Lord Rippon 

 

Q2. Give short answers of the following.    Pg. 35 

Q i. What is meant by Khilafat Movement? 

Ans: During the World War I, Turkey lost the war. British decided to divide 

Turkey. The Indian Muslims were very disturbed on the situation 

because they had a deep-rooted respect for the Holy places. So, 

Muslims of Sub-continent started a movement to support Turkish 

people. This movement is called Khilafat Movement. 

 

Q ii. When Dyarchy system was started? 

Ans:  Dyarchy System was started by British government for the firs time in 

provinces under the Indian Act of 1919. 

Q iii. What were the objectives of establishment of Muslim League? 

Ans:  The objectives of establishment of Muslim League were: - 

1. To promote among the Muslims of India the feelings of loyalty to the 

British government and to remove misconception. 
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2. To promote and advance the political rights and interests of Muslims of 

India and to represent respectfully the needs and requirements to the 

government. 

3. To prevent the rise of any feeling of hostility towards other 

communities. 

Q iv. Why Civil Disobedience Movement was started? 

Ans:  Civil Disobedience Movement was started because all the Muslim 

leaders were sent behind the bar during the Khilafat Movement. Gandhi 

was a clever leader. He announced to boycott the English products and 

schools and  elections. The Muslims boycotted the court, schools and 

civil services. They returned the titles too. So, the Muslims were sent to 

jails. But Quaid-e-Azam was against this Movement. He advised the 

Muslims to avoid violence. 

Q v. What is meant by Reshmi Rumal Movement? 

Ans:  Reshmi Rumal Movement ( Silk Letter Movement). During 1915-16 some 

students and political workers planned to liberate India. For this 

purpose, they went to Afghanistan to wage war against the British 

government. So, Maulana Ubaidullah Sindhi, a Hindu’s delegation, 

Germen and Turkey persuade afghan government to attack Sub-

continent. 

 Ubaidullah Sindhi wrote a secrete message on Silk Letter and dispatched 

to Mehmud-ul-Hassan about all their activities. But this letter was 

caught by the functionaries of the government. The British took 

appropriate steps to stop attack. 

  Tick (    ) against right answer and (  ) against wrong answer.  Pg. 35 

(i). Mr. A.O. Hume was an officer of Indian civil service. 

(ii). In 1892, the commissioner of East Bengal had proposed for the separation 

of the province. 

(iii). Bengal was partitioned in 1908. 

(iv). Quaid-e-Azam (R.A.) played an important role in the Pan-Islamic 

Movement. 

(v). Maulana Muhammad Ali Juhar played an important role in Khilafat 

Movement. 
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Q3. Fill in the blanks.       Pg. 35, 36 

I. Dyarchy system was not successful in Bengal and Punjab. 

II. Muslims showed severe reaction on the annulment of partition of Bengal. 

III. Quaid-e-Azam (R.A.) played an important role as an ambassador of Hindu-

Muslim unity . 

IV. Quaid-e-Azam (R.A.) was not in favor of  civil disobedience  movement of 

Gandhi. 

V. Muhammadan Educational conference’s annual meeting was held in 

December 1906 at  Dacca. 

 

Q4. Relate columns A with Column B. Put correct answer in Column C. P.36 

Column A Column B Column C 

Khilafat Movement 1885 
Maulana Muhammad 

Ali Juhar 

Establishment of 

Congress 
1916 1885 

Establishment of  

Muslim League 
1905 Dacca 

Partition of Bengal Dacca 1905 

Lucknow Pact 
Maulana Muhammad 

Ali Juhar 
1916 

 

Q5. Write detailed note on the following.   P.36 

Q i. Discuss the back ground of establishment of Muslim League? 

Ans: After the success of the Simla Deputation the Muslims decided to form 

their own organization. So, the Muslims held a meeting in October, 1901. 

The League’s aims were to protect and promote Muslim’s rights and 

interests at national level. 

 In December, 1906, an annual meeting of Muhammadan Conference was 

held at Dacca. All-important Muslim Leaders of Sub-continent attended 

the meeting and they discussed educational problems and considered 

about the formation of political party for Muslims of sub-continent. At the 

end of the conference, a special meeting under chairmanship of Nawab 

Waqar-ul-Mulk was held on December 30, 1906 in which a resolution for 

the establishment of All India Muslim League was presented by Nawab 

Saleem-Ullah Khan which was adopted unanimously. 
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Q ii. Discuss important points of the Lucknow Pact? 

Ans:  The important points of the Lucknow Pact were:  

1. Congress accepted the principle of separate electorate for Muslims. 

2. Congress agreed to give 1/3 representation to Muslims in central 

Legislative Council. 

3. Both parties agreed on the weightage formula under which the Muslims 

would get less representation than their population in the Legislative 

Council in those provinces, where they were in majority but more in the 

provinces, where they were in minority. 

4. In the central or provincial assembly, a non-official shall not present a bill 

or resolution against a community not shall be approved without the 

approval of ¾ members on community. 

Q iii. Discuss role of Quaid-e-Azam (R.A.) as an ambassador of Hindu Muslim 

Unity? 

Ans:  Quaid-e-Azam (R.A.)’s role as an ambassador of Hindu-Muslim Unity was 

as under: 

 After Khilafat Movement, the outlook of Muslim politics changed. The 

religious people participated in politics and betrayal of Hindu highlighted 

the political wisdom of Quaid-e-Azam (R.A.). In 1924, Quaid-e-Azam (R.A.) 

recognized Muslim League and started efforts for Hindu Muslim Unity. 

Both parties constituted a reform committee under the leadership of 

Quaid-e-Azam (R.A.). The committee held its sessions in Calcutta and 

Lucknow and approved many proposals. Quaid-e-Azam (R.A.) played a key 

role in this regard. Therefore, Mrs. Sarojini Naidu called Quaid-e-Azam 

(R.A.) as an ambassador of Hindu-Muslim Unity. 

 Quaid-e-Azam presented Delhi proposals on March 20, 1927, for the 

purpose of unity. In the beginning, congress appreciated the effort but 

later published Nehru-Report, which spoiled the effort of unity. In fact, 

Quaid-e-Azam continued to work for the unity until he was convinced that 

Hindu leaders were not in favour of unity. He became disappointed and 

had to say that we have different ways from Hindus. Thus, both the 

nations parted their ways. 

Q iv. Discuss Khilafat Movement which was started in sub-continent? 

Ans: The Khilafat Movement started in 1919, after the World war I. First World 

War, Turkey joined Germany against Britain. Turkey and Germany lost the 

war. The British did not fulfill its promise. The Sultan of Turkey who was 

also head of the Ottoman Empire, was considered as the religious head of 
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the Muslims Community. Maulana Muhammad Ali Johar and his brother 

Maulana Shaukat Ali played a key role in the movement.  

 When leaders of Khilafat movement announced to launch a Non-

Cooperation Movement, Congress extended full supportto the Khilafat 

Movement. 

 Gandhi used the Muslims for the benefits of the Hindus. Suddenly Gandhi 

announced to stop the movement. The Muslims were surprised. In 1924, 

Mustafa Kamal Ataturkabolished the Khilafat Movement. During Khilafat 

Movement, Hindus Muslim unity was exemplary. i-e; Hindu Muslim Bhai 

Bhai.But on the end of Movement, the unity of both nations reverted to 

enmity.  

Q v. Discuss Civil Disobedience Movement and its effects on unity of Hindu-

Muslim? 

Ans:   Civil Disobedience Movement started when all the Muslim leaders were 

sent behind the bars, during the Khilafat Movement. Hindu leaders took 

steps forward to help Muslims. Gandhi was a clever leader who wanted to 

compel British government and announced to boycott the English 

products, school, colleges, courts and councils. He also asked the Indians 

to give up any titles and positions awarded by the British government. 

 Effects of Civil Disobedience Movement on Hindu-Muslim unity: - 

 Followings were the effects of Civil Disobedience Movement on Hindu-

Muslims unity: - 

 The Muslims boycotted the court, withdrew their children from schools 

and colleges, returned their titles and left the civil services. So, in the 

movement, thousands of Muslims were sent to jails. Quaid-e-Azam did 

not agree with. He advised Muslims to avoid violence and not become 

tools in the hands of Hindus. So, the movement was finally called off. 
 

Q vi. Discuss the establishment of Indian National Congress and its 

objectives? 

Ans:   Indian National Congress was established by Mr. Allan Octavian Hume. 

When Hume was in service, he thought that increasing political unrest, 

economic difficulties and increasing conspiracies might create rebellion. 

Therefore, there was a need of an organization through which they might 

express their grievances. So, he established Indian National Congress at 

Bombay in 1885. Its first meeting was held on December 28, 1885 in 

which 70 delegates participated in the meeting out of which only two 

were Muslims. 
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 Objectives of Indian National Congress: - 

 The objectives of Indian National Congress were:  

1. To evolve a sense of nationhood among the Indians. 

2. To address the grievances of the Indian people. 

3. To re-organize the people in culture, politics and morality. 

4. To work for the welfare of Indian people. 

 

Q vii. Discuss the background of partition of Bengal? 

Ans:  The background of partition of Bengal is as under: - 

 By the beginning of 20th century, Bengal was the biggest province of sub-

continent with regard to population and territory. On many occasions the 

officials proposed to cut its areas. In 1892, the commissioner of 

Chittagong proposed separate East Bengal, but the proposal could not be 

implemented.  

 On 16th October, 1905, Lord Curzon divided Bengal into East Bengal and 

West Bengal. East Bengal a Muslim majority area, was under developed 

and lacked basic facilities. Whereas, West Bengal was a well-developed 

Hindu majority province. Hindus opposed the partition. They boycotted 

and held protest rallies everywhere in India. Muslims of India were very 

happy over the partition as there was possibility of development of 

Muslims. 

 Hindus refused to give loans to Muslim harvesters and threatened 

Muslims labourers. They tried to pressurize the government to undo the 

partition. Finally, on 12 December, 1911, after just six years, Bengal was 

reunited. 

===================================== 
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Sardar Kaurey Khan Public H/S School 
Syllabus for the month of September 1st Term,2020 

 
Subject: Computer   Class: 8th  Teacher: Zahra Hanif 
Month Week Dates W.Days Topic/Content 

Sep 
2020 

1 31-05 6 
Unit # 3: Creating different spreadsheets, 
Saving a spreadsheet  

2 7-12 6 
Formatting worksheet elements, 
Formatting texts,   

3 14-19 6 
Applying borders and background colors, 
Inserting new rows and columns  

4 21-26 6 
Inserting charts, Line chart, Column chart, 
Bar chart, Pie chart 

5 28-3oct 6 Revision + Self-Assessment 

 
Unit # 3:- 

“SPREADSHEETS IN EXCEL” 
 
11) How to create a new Spreadsheet in Excel? Also create a monthly result sheet. 
The following steps are used to create a new spreadsheet.  

 Click the File.   

 Select New command. 

 The new workbook dialog box opens and blank workbook is highlighted by 
default. 

 Click Create. A new, blank workbook appears in the window.   
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Creating Result Sheet: 

 Click on A1 and type “ABC SCHOOL”.  

 Click on A2 and type “Result Sheet”.  

 Click on A3 and type “Class 8th”. 

 Click on A6 and type “Roll No.”. 

 Click on B6 and type “English”.  

 Click on C6 and type “Urdu”. 

 Click on D6 and type “Science”.  

 Click on E6 and type “Islamiyat”. 

 Click on F6 and type “S. Studies”.  

 Click on G6 and type “Computer”. 

 Click on H6 and type “Total Marks”. 

 Click on I6 and type “Marks Obtained”.  

 Click on J6 and type “Percentage”.  

 Type data in the sheet under the all above headings, as shown in below figure.  

 Click on I7 and type “= SUM (B7:G7)”. Copy the “= SUM (B7:G7)” formula on 
the I7 to I11 by the by the Auto Fill Command of Excel.  

 Click on J7 and type “= (I7/600)*100”. Copy the “= (I7/600)*100” formula on 
the J7 to J11 by the by the Auto Fill Command of Excel.   
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12) What is formatting? Give a procedure to select a cell and range of cells to 
apply formatting. 
Changing the appearance of a Cell’s content is 
known as formatting. Formatting data makes the 
work more beautiful and more readable.  
To select a single cell:  

 Click on the cell to select it.  OR  

 Move the cursor over to the desire cell by 
using the navigation keys.  

Selecting a Range of Cells: 
 
To Select Adjacent Cells:  

 Click the first cell.  

 Hold down the Shift Key and click the last cell. OR  

 Hold down the left mouse button on the first cell and drag the mouse to the 
last cell.  

To Select Non-adjacent Cells: 

 Click the first cell.  

 Hold down the Ctrl key and click multiple cells to select, as shown in figures. 
After selecting a cell or range of cells, the user can apply any formatting 
commands 

 
13) What is difference between Copy-Paste and Cut-Paste? 
The Copy-Paste option is used to take the duplicate of the selected cell contents 
by copying them and pasting them where required. This option does not remove 
the text from the source location.  
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The Cut-Paste or Move option is used to move text from one place (source) to 
another place (destination). When users cut or Copy text, it gets placed on the 
clipboard.  
 
14) What is text formatting? Give procedure to change font, font size and font 
style in Excel. 
Text formatting includes formatting the font size, style, and color; and using the 
Bold, Italic, Underline, and aligning the text. User can format a single cell or range 
or cells. Below figure shows formatting tools. 

 
Font: 
It is the typeface of text and it is a set of characters used in typing of text in a 
particular style. Excel provides many different fonts from which user can choose.  
To Change Font:  

 Select cells to change the Font. For example G4 to J4. 

 Choose the Home tab. 

 Click the down arrow next to the Font box. A list of fonts appears.  

 Find and click the required font from the list. For example Arial Black as shown 
in below figure. 
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To Change Font Size: 

 Selecting cell or cells to change the font size. 

 Choose the Home tab.  

 Click the down arrow next to the Font Size Box. A list of font sizes appears. 
Click on the required size. Below figure shows how to change the font size. 

 
Font Style: 
There are four Font style available Bold, Italic, Underline and regular.  
To Change the Font Style: 

 Select cell or cells to change the style.  

 Choose the Home tab.  

 Click the required Font Style (Bold, Italic or Underline, ). 
Following figure shows how to change the font style. 
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15) What is a border? Give procedure to apply a border and background colour 
to a cell/range of cell borders in Excel. 
Borders are outlines around the cell or cells. User can use borders to make entries 
in worksheet stand out.  
To Apply Borders:  

 Select cell or cells to apply borders.  

 Choose the Home tab.  

 Click the down arrow next to the Borders button, a menu appears.  

 Click the required border option.  

 Excel applies the selected border to the selected cells, as shown in figure.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To add background Color:  

 Select cell or cells to add 
background color.  

 Choose the Home tab. 

 Click the down arrow next to the 
Fill Color button.  

 Click on the required color, for 
example Light Green. Excel applies 
Light Green background color in the 
selected cells as shown in below 
figure.   
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16) Give procedure to insert new rows and columns in Excel. 
Users can insert blank rows or columns in a worksheet. Follow these steps to 
insert a row or column.   
To insert a row/Column  

 Right-click where you want to insert a row/column. 

 
 

 Click Insert option. A menu appears as shown in above figure.  
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 Click any of the following options. 
1. Shift cells Right: This option shifts the selected cell/cells to the right hand row. 
2. Shift cells down: This option shifts the selected cell/cells downward in the 
same column.  
3. Entire row: Insert new rows equal to the number of selected cell(s). The 
selected cells shift downward.  
4. Entire column: A blank column in inserted to the left of selected cell(s). 

 
17) What is a chart? Name any three types of charts used in Excel. 
Charts are the graphical representation of data entered in a worksheet. Charts are 
helpful in showing the comparison between different categories. Different types 
of charts are used for different purposes. Excel offers many types of charts 
including column, Line, Pie, Bar, Area, Scatter and more as shown in below figure. 
 

 
 
18) Write down the procedure to following:  
a. To insert the column chart. b. To insert the line chart.c. To insert the pie 
chart. 
Ans: To Insert Column Chart: 

 Select cells in the sheet as data for 
column chart. For example A1 to E6 as 
shown in below figure.  

 Choose the insert tab. 

 Choose the Column button in the 
Charts. A list of column chart sub-types 
appears.    

 Click the required chart sub-type. For 
example, Clustered Column charts sub-
type. 

 Excel inserts a Clustered Column chart as shown in below figures. 
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To Insert Line Chart: 

 User can also change the chart type from a column chart to a line chart.  

 Click the chart to change chart. The chart tools become available.  

 Choose the Design tab. Excel changes chart type to Line chart. 

 
c. To insert Pie chart   
Pie charts are used to show percentages. The circle of pie charts represents 100%. 
The circle is sub-divided into slices representing data values. The size of each slice 
shows what part of the 100% it represents. 

 Select the cells to include as data for Pie chart. For example the cells A2 to E6.  

 Click the Insert menu.  

 Click Pie from the Charts.  
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 Click the down arrow and select the first Pie chart sub-type.  

 
 

MCQs:  
 
8. The active cell is the cell which is currently.  
(a) Selected  (b) Deleted (c) Created (d) Edited  
9. Two cell references are used for a range of cells separated by.   
(a) Colon (:)    (b) Semi-colon (;) (c) Full stop (.)    (d) Equal sign (=)  
10. Changing the appearance of a Cell’s content is known as.  
(a) Designing     (b) Formatting   (c) Auto filling    (d) None of these  
11. How many types of cell alignments in MS Excel?  
(a) Two  (b) Four  (c) Six  (d) Ten  
12. The graphical representation of data entered in a worksheet is known as: 
(a) Table     (b) Chart   (c) Graph     (d) All of these   
13. Which of the following bars gives access to the frequently used commands in 
Excel? 
(a) Quick Access Toolbar  (b) Formatting Toolbar  (c) Status bar  (d) Scroll bar 
14. __________ are arranged vertically in an Excel worksheet. 
(a) Rows  (b) Columns  (c) Cells  (d) Active cells 
15. __________ consists of the column letter and row number that intersect at 
the cell’s location. 
(a) Cell address  (b) Cell location (c) selected cell  (d) Active cell 
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THE MONTH OF NOTES: SEPTEMBER 2020 

SUBJECT : MATH  

      CLASS: 8TH  

SYLLABUS :                                TERM : 2ND  

week Date 
Working 

Day 
Activity Topics / content 

1 
31aug-
5sep 

6 
Ex6.1+6.3 Unit 6 (FRECTORIZATION,SIMULTANEOUS EQUTION) 

2 7-12 6 Ex 6.4+6.5  
3 14-19 6 Ex 6.6 + 6.7  

4 21-26 6 

Ex6.9 
(Q.1)+6.11+OBJ 6 
(Q.1,2+SUMMARY 
COMPLETE) 

 

5 
28sep-

3oct 
 

 Revision + assessment 

                                      

                               UNIT  NO.6 

{FACTORIZATION;SIMULTANEOUS 

EQUATIONS} 

EXERCISE:  6.1                  

BASIC ALGEBERAIC FORMULAS 

(a+b)2 = a2 + 2ab + b2 

Q-1 Evaluate (107)2by using formula: 

Solution : (107)2=(100+7)2 
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 =(100)2 +2(100*7)+(7)2 

 =10000 + 1400+ 49 

 =11449 

Q: (a-b)2 = a2 -- 2ab + b2 

Using the formula, evaluate (87)2 

Solution : (87)2 = (90-3)2 

 =(90)2 -2 (90*3) + (3)2 

 =8100 -590+9 

 =7569 

Q: a2-b2 = (a+b)  (a-b) 

Using the formula,evaluate 107x93 

Solution : 107x93 = (100+7) (100-7) 

 =(100)2-(7)2 

 =10000-49 

 =9951 

Q: Find  the value of x2+1/x2  and x4 +1/x4when  x-1/x=2 

Solution : Here x-1/x =2 

 [x-1/x]2=(2)2 

 x2 -2(x) [1/x]+[1/x]2 =4 

 x2-2+1/x2 =4 

 x2 -2+2+1/x2 =4+2 
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 x2+1/x2 =6 

[x2 + 1/x2  ]2=62 

(x2)2+2(x2)[1/x2]+[1/x2]2 =36 

 X4+2+1/x4 =36 

 X4+1/x4 =36-2 

 X4+1/x4=34 

                                          EXERCISE 6.1 

Solve the following questions by using formulas: 

1. Evaluate square of each of the following: 

(a) 53         (B)  77       (C)  509     (D)   1006 

2. Evaluate each of the following : 

(57)2         (95)2              (598) 2                   (1997)2 

3. Evaluate:  

46*54     197*203       999*1001        0,96*1.04 

i.  Find the  value of x2+1/x2 , when  x+1/x  =7 

ii. Find the value of x2 +1/x2 , when x-1/x    = 3 

iii. Find the value of x4 +1/x4, when x-1/x   =1 

FECTORIZATION   EX 6.3 

Factors of an expression are the expressions whose product is the given 

expression. 
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The process of expressing the given expression as a product of its factors is called 

. Factorization  or factorizing. 

                                         Exercise No: 6.3 

i. Type       ac + ad + bc + bd 

Q:1. Factorize: 3x +cx +3c +c2 

Solution : 3x +cx +3c +c2 

 =(3x +cx) + (3c +c2) 

 =x(3 +c) +c(3+c) 

 =(3+c) (x +c) 

Q:2. Factorize : 2x2y – 2xy + 4y2x – 4y2  

Solution : 2x2y – 2xy + 4y2x – 4y2 

 =2y (x2 – x + 2yx -2y) 

 =2y[x(x-1) + 2y (x-1)] 

 =2y ( x – 1 ) ( x + 2y) 

Similarly  attempt all questions of ex. 

                              EXERCISE:  6.4 

ii. Type a2 ± 2ab + b2 

Q.1. Factorize 9a2 + 30ab +25b2 

Solution : 9a2 + 30ab +25b2 

 =(3a)2 +2 (3a X5b) + (5b)2 

 =(3a +5b)2 
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Q:2. Factorize: 16 x2  -64x +64 

Solution : 16 x2  -64x +64 

 =16(x2 -4x+4) 

 =16[(x)2   -2 (2) (x) +(2)2] 

 =16(x -2)2 

Q:3. Factorize : 8x3y + 8x2y2 +2xy3 

Solution :        = 2xy (4x2 +4xy+y2) 

 =2xy[(2x)2+2(2x)(y)+(y2)] 

 =2xy (2x +y)2 

Similarly attempt all questions of ex. 

                           Exercise No: 6.5 

Type a2 – b2 

Q :1. Factorize : 25x2 -64 

 =(5x)2 –(8)2 

 =(5x+8)(5x-8) 

Q:2. Factorize :16 y2b – 81bx2 

Solution : 16 y2b – 81bx2 

                          =b (16y2 -81x2) 

 =b [(4y)2 – (9x)2] 

 =b ( 4y +9x ) (4y – 9x) 

Q:3.Factorize : (3x-5y)2 -49z2  
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    Solution :       (3x-5y)2 -49z2 

 =(3x-5y)2 –(7z)2 

 =(3x-5y + 7z ) (3x -5y -7z) 

Q:4. Factorize :  36 (x+y)2 -25 (x-y)2 

Solution : 36 (x+y)2 -25 (x-y)2 

 =[6(x+y)]2 – [5(x-y)]2 

 =[6(x+y) +5(x –y )] [6(x+Y) – 5(x –y)] 

                  =[6X+6y+5x-5y][6x+6y-5x+5y] 

 =(11x+y ) (x+11y) 

Q: 5.Use Formula to evaluate : (677)2 –(323)2 

Solution : (677)2 –(323)2 

 =(677 +323) (677-323) 

 =1000x 354 

 =354000 

Q:6. Simpalfy:       0.987*0.987-0.643*0.643 
                                      0.987+0.643 
 
                 0.987*0.987-0.643*0.643 
                                      0.987+0.643 

           =(0.987)2 – (0.643)2 

       0.987+0.643 

                             =(0.987+0.643) (0.987-0.643) 
 0.987+0.643 

 =0.987-0.643 
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 =0.344 

Similarly attempt all questions of ex. 

                                         Exercise No: 6.6 

Type :     a2 ±2ab +b2 – c2 : 

Q:1.         a2-2ab + b2 -4c2 

Solution : (a2 -2ab +b2)-4c2 

 =(a-b)2 – (2c)2 

 =(a-b -2c) ( a –b + 2c) 

Q:2.        4a2 + 4ab +b2 -9c2 

Solution : 4a2 + 4ab +b2 -9c2 

          =(2a)2 + 2(2a)(b) +(b)2 – 9c2 

=(2a+b)2 –(3c)2 

=(2a +b – 3c ) (2a + b + 3c)  

Similarly attempt all question 

 Exercise No: 6.7 

Formula ( a+b)3 = a3 + 3ab (a+b) + b3 

Q:1. Expand (3a + 4n)3 

Solution : (3a + 4n)3 

 =(3a)3 + 3(3a)(4b) (3a + 4b) + (4b)3 

 =27a3 +36ab (3a +4b )+64b3 

 =27a3 +108a2b +144ab2 +64b3 
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Formula (a –b)3 = a3  -  3ab (a-b) –b3 

Q:1. Expand ( 2a – 3b)3 

Solution : ( 2a – 3b)3 

 =(2a)3 – 3(2a)(3b)(2a – 3b) – (3b)3 

 =8a3 -18ab (2a -3b) – 27 b3  

                    =8a3 -36a2b + 54ab2 -27 b3 

Q:2. IF x+1/x = 5 then find the value of x3 + 1/x3 

Solution : We have, x+1/x  = 5 

                     [x+1/x]3 = (x)3 +3(x) [1/x] x [x+1/x]+[1/x]3 

 [x+1/x]3 =x3 +3[x+1/x] +1/x3 

 [x+1/x]3 = x3+1/x3+3[x+1/x] 

 (5)3 = x3 +1/x3 +3(5)         ῭       [x+1/x] =5 

               125 =x3+1/x3 +15 

 =X3+1/x3 =125-15 

 =X3+1/x3 =110 

Similarly attempt all questions of ex. 

SIMULTANEOUS LINEAR EQUATIONS . 

If two or more linear equations consisting of same set of variables are satisfied 

simultaneously by the same values of the variables,then these equations are 

called simultaneous linear equations . 

SOLUTION OF SIMULTANEOUS LINEAR EQUATIONS 
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The solution of simultaneous linear equations means finding values for the 

variable that make them true sentences . 

                               

                               Exercise No: 6.9 

Method of equating the coefficients 

Q:1. Find the solution with the  mothod of  equating the coefficients  

 9x  +  8y   =1 

 5x   -  y   =  6 

Solution : 9x  +  8y  =  1  ……………….1 

 5x   -  y   =  6 ………………….2 

Step  1: Convert the given equation into an equivalent equation in such a way that 

the coefficient of one variable must be same .Multiply both sides of equation(!! )  

by 8, we have  

 8(5x –y) = 8(6) 

 40x -8y  = 48     ……………( ïіі) 

Step 2:   Add equations (ï) and (ïіï) to find the value of one variable . 

 9x  + 8y  =1 

 40x – 8y  =48 

                                                    49x           =49 

   x=49/49 =1 

step 3: Put the value of “x” in equation (ï) or (ïі) to find the value of “y” 

 5x – y  =6 
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 5(1)  - Y =6 

 5 -  y      = 6 

 Y   = 5  - 6 =  - 1 

Thus , x = 1 and y = -1 is the required solution . 

Step 4:   Check the answer by placing the values of “x” and “y” in any equation . 

 9x  +  8y   =1 

 L.H.S         =9x  +  8y 

 =9(1) +8(-1) 

 = 9  - 8   =  R.H.S 

Similarly attempt all parts 0f question(1) of ex. 

Exercise No: 6.11 

ELIMINATAION OF A VARIABLE FROM TWO EQUATIONS 

At least two equations are required for elimination of one variable . 

There are different method of elimination , but we learn here only two method. 

(a) Elimination of variable from two Equations by Substitution 

Q:   Elimination “x” From the following equations by substitution method . 

                                                   ax  -   b  =  0 

 cx   -  d   = 0 

Solution:                Given : 

Ax  -   b  =  0                  …………..(і) 

 cx   -  d   = 0              …………..(ïі) 
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From equation (і) we  have  

Ax = b  or x = b/a 

Put the value of x in equation (ïі) we get 

c [ b / a ] - d  = 0 

    bc –ad =0           

  Bc= ad          Here “x” is eliminated. 

Q: Elimination “x’’ from ax2  +  bx  +  c  =0  and lx  +  m  =  0 by substitution 

methed. 

Solution :     

 

 

   ax2  +  bx + c  =  0    ……….(і) 

      lx  +  m       =  0    …………( іі) 

From  equation  (і і) ,we have,  

            Lx +  m   = 0     ->    x = -m/l 

Put the value of x in equation (і) 

 A[-m/l]2   +  b  [-m/l]  + c = 0 

 

  a m2/l2   -  b m/l  + c  =  0 

 Am2 /l2  -bm /l  + c    =    0 (Multiply equation by l2 

 am2  -  blm   +  cl2   =    0 

 This is the required result. 

 Q:eliminate  vi from equation. 

 Vf=Vi+at  ……………1 

 S=Vit+1/2at2  ………..2 

 Eliminate vi  from eq.1 
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Vf-at=Vi 

Put value of vi in eq.2 

S=(Vf-at)t+1/2at2 

S=Vft-at2+1/2at2 

S=Vft-1/2at2 

2S=2Vft-at2 

2S=t(2Vf-at)  

similarly attempt all questions of ex. 
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Sardar kaurey khan Public Higher secondary school Muzaffargarh 

              Self-assessment English 8th for September 2020     

Student’s Name_________________________________ 8th sec___   Girls/Boys 

Date _________________                                                                 Total Marks :25 

Q1: Make sentences by using the following phrases.            /5 

Again and again, more or less , by and by, to and fro, through and through.                                                                 

Q2:correct the following by inserting correct relative pronouns .     /5                                                                 

1:The man which 

came._______________________________________________ 

2: The horse who carried 

me___________________________________________ 

3: The girl which 

sings_________________________________________________ 

4: The ox who draws the 

plough.________________________________________ 

5: The man which drives the ox. 

________________________________________ 

Q3: Express the following sentences in present tense                                  /5 

1: Ali wrote a letter . 

________________________________________________     

2:He was a lazy boy   

________________________________________________ 

3:The trees had many 

leaves._________________________________________  
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 4: The news flew like lightning through the land    

________________________________________________________________ 

5:The child will serve his country as his father did.      

________________________________________________________________ 

Q: 4 change the voice.                                                                /5      

1: A cat killed a mouse. _____________________________________________ 

2: She is writing a letter ____________________________________________ 

3: Aslam has chosen a book.  ________________________________________  

4: Who has written this letter? _______________________________________ 

5: Love your parents. ____________________________________________  

Q5: Write five sentences about  /5 

What you feel after you have attempted the questions assessment       
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Sardar Kauray Khan Public Higher Secondary School M garh                                                         

SELF ASSESSMENT 

    Class: 8thsubject: science 

Student name:                            .Section:          Total marks: 25total time: 1hour 

Q.1 encircle the correct answer 

1) An electronic balance is used to measure  

a) Electric current                                          b) length  

c) Mass                                                             d) volume  

2) SI unit of mass is:  

a) Kilogram                                                        b) kilometer  

c) Pound                                                             c) ounce  

3) Which of the following liquid makes the meniscus opposite to the others?  

a) Mercury                                                         b) water  

c) Alcohol                                                           d) petrol  

4) Which of the following is the SI unit of volume?  

a) m                                                                      b) m2 

c) m3                                                                       d) kg                 

(v) A mass of 2 kg is equal to: 

a) 1,000 g                                                                  b) 2,000 g 

c)2,500 g                                                                 d) 3,000 g 

(vi) Which of the following relation is correct relation? 

a) 1 min = 60 h                                                     b) 1m = 1,000 cm 

c) 1mL = 1 cm3                                                    d) 1min = 30 s 
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(vii) A length of 50 mm is equal to: 

a) 0.5 m                                                                    b) 0.05 m 

c) 0.005 m d) 0.0005 m 

(viii) 25 cm3 is equal to: 

a) 25 mL                                                                                                     b) 2.5 mL 

c) 0.25 mL                                                                                                 d) 250 mL 

(ix) One kilometer is equal to: 

a) 100 m                                                                                                     b) 500 m 

c) 1,000 m                                                                                                   d) 10,000 m 

(x) Pipettes are commonly used for: 

a) Making solutions 

b) Measuring the volume 

c) Transferring a measured volume 

d) Measuring mass 

                                         Part: 2(subjective)                                . 

Q.2 gives short answers                                                 2*5=10 

(i) Define a physical quantity. 
(ii) Define the term prefix. 
(iii) What is a meter rule? 
(iv) How many milliliters are there in one dm3? 
(v) How many seconds are there in one solar day? 

 

Q.3 long question (5) 

Describe the use of measuring cylinder. 
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Sardar Kaurey Khan Public Higher Secondary School Muzaffargarh 

Self-Assessment for the month of September, 2020. 

Subject: S.St.       Class: VIII   

  

Total Marks: 15       Sec._______ 

Name: ______________________________________________________  

Q1. Tick () the Correct answer.      /5 

i. Ozone layer is depleting due to: 

a) water pollution   b) soil pollution 

c) noise pollution   d) air pollution 

ii. Toxic gases enter the atmosphere due to: 

a) noise pollution   b) deforestation 

c) putting waste of fire  d) use of chemicals fertilizers 

iii. Muslim League was established in: 

 

a) 1900     b) 1906 

 

c) 1910     d) 1916  

 

iv. Simla Deputation met whom? 

 

a) Lord Canning   b) Lord Curzon 

 

c) Lord Minto    d) Lord Rippon 

 

v. In which year partition of Bengal was annulled? 

 

a) 1911     b) 1913 

 

c) 1915     d) 1917 
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Q2. Give short answers:     /10 

i. What is meant by pollution? 

Ans:____________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________ 

ii. Name the types of pollution? 

Ans:____________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________ 

iii. What is meant by global warming? 

Ans:____________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________ 

iv. When Dyarchy System was started? 

Ans:____________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________ 

v. Objectives of establishment of Muslim League? 

Ans:____________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________ 
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11 Computer   8th Class | Zahra Hanif                                                                                SKKPH/S School   

 

Assessment for the month of September 
 

Subject: Computer Class: 8th 
Section: ______________              Date: _______________ 
Name:_______________ 
 
Q1) Choose the right answer and circle it.                                                             /10 
1. Which of following is the intersection of a row and a column? 
 (a) Form  (b) Query   (c) Cell  (d) Table  
2. How many worksheets by default are provided in a workbook to enter data? (a) 
One  (b) Two  (c) Three  (d) Five  
3. In MS Excel the Save, Undo, and Redo commands appear on:   
(a) Title Bar    (b) Quick Access Toolbar   (c) Formula bar    (d) Status bar  
4. The active cell is the cell which is currently:   
(a) Selected  (b) Deleted (c) Created (d) Edited  
5. Changing the appearance of a Cell’s content is known as:   
(a) Designing     (b) Formatting   (c) Auto filling    (d) None of these  
6. How many types of cell alignments in MS Excel? 
(a) Two  (b) Four  (c) Six  (d) Ten 10.  
7. The graphical representation of data entered in a worksheet is known as:  
(a) Table     (b) Chart   (c) Graph     (d) All of these   
8. Which of the following bars gives access to the frequently used commands in 
Excel? 
(a) Quick Access Toolbar  (b) Formatting Toolbar  (c) Status bar  (d) Scroll bar 
9. __________ are arranged vertically in an Excel worksheet. 
(a) Rows  (b) Columns  (c) Cells  (d) Active cells 
10. __________ consists of the column letter and row number that intersect at 
the cell’s location. 
(a) Cell address(b) Cell location (c) selected cell  (d) Active cell 
 

Q.2: Give short answers:         /10 
1)What is difference between Copy-Paste and Cut-Paste? 
2) What is a border? 
3) What is text formatting? 
4)What is a chart?  
5) Name any four types of charts used in Excel. 
Q3:  Write down the procedure to insert the Pie Chart  /05 
 

 
 ____ 
      25 
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SARDAR KAUREY KHAN PUBLIC H/S SCHOOL 

 

 

AMINA NAZIR 

Assesment for the month of SEPTEMBER:                 
 

Subject…Math     class 8th   Sec…. 

                 

Student Name :      …………………………….. 

                 

Total Marks : 25 

 

Q.1= Tick the correct option. 

-1: After eliminating “x” from ax2 = b amd cx2 =d we get: 

  (a)    bc= ad   (b)  bd=ac    (c)  abc = d 

-2: if x – 1/x = 3 then x3-1/x3 =? 

 (a)  27   (b)  18  (c)  36 

-3: (a+b)(a-b)…. ? 

(a) a2 –b2  (b) (a-b)2  (c) (a+b)2 

-4: a2-2ab + b2 ….? 

(a)  a2 –b2  (b) (a-b)2 (c)  (a+b)2 

-5: a2+2ab + b2  

(a) (a+b)2 (b)  a2 –b2  (c)  (a-b)2 

-6: if x+ 1/x =9 then x2 +1/x2 ….? 

(a)  81  (b)  79 (c)  87 

 -7: a(x-y) –b (x-y) ….? 

(a)  a-b  (b)  x-y  (c) (a-b)(x-y) 

-8 :  9-x2  …….? 

(a)  3+x  (b)  x-3  (c)  (3-x)(3+x) 

-9: 5x3 – 45x =  …..? 

(a) 5x   (b) 5x(x-3)    (c) 5x(x-3)(x+3) 
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AMINA NAZIR 

-10: x2+14x+49=…..? 

(a)  (x-7)2  (b)  ( x-7)(x+7)   (c)  (x+7)2  

-11: x2 + 3x -4x - 12 ….? 

(a)  (x+3)(x+4)  (b)  (x+3)(x-4) (c) (x-3)(x+4) 

-12: square of  99 by formula is  …..? 

(a) (100)2 – 2 (100)(1)+(1)2  (b) (100)2 + 2 (100)(1)+(1)2  (c) (100)2 + 2 (100)(1)-(1)2  

-13: if x+y = 6, x-y = 2 then y = ….? 

(a) 4  (b)   2       (c)   6  

-14: if x+y = 2  x-y = 0  then x = ....? 

(a) 1  (b) 0  (c) 2 

-15:if x+y = 6, x-y = 2 then x =  …? 

(a) 2  (b) 4  (c)  6 

Q.2: Attempt Short question : 

-1: Define simultaneous linear equation   

-2. Write any three methods for solving  simultaneous linear equation   

-3: How many equation are required for elimination of one variable …? 

-4: Write cubic formulas  

-5:  Define fectors  
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SARDAR KAUREY KHAN PUBLIC HIGHER SECONDARY SCHOOL MUZAFFARGARH 

ASSESSMENT FOR THE MONTH OF AUGUST & SEPTEMBER 

NAME: ___________________    SUBJECT: URDU       CLASS: VIII 

۔                                                                                        اگلےیئ ن  اشن رگد  ےک  اب  وج تس   در

رلی ےک رفس ںیم رویٹ ےس ڑلات ےہ۔1  

ن  (ج)  اپین (ب)   اسنل (افل  ٹیلپ(د)درتس وخا

 رک ریہ یھت۔ ـــــــــــــــــدنمش یک وفج لسلسم - 2

 اھچیپ(د)ہضبق  (ج)  وگہل ابری(ب)   ہلمح (افل

 اپاتسکن یک اہیک میٹ یلہپ رمہبت نیب االوقایم اقمولبں ںیم رشکی وہیئ۔-3

 1967(د)  1956(ج)  1948(ب)   1931 (افل

 یک ومثن ےہ۔" وخاہج"-4

 اخوتن(د)وخایج  (ج)  وخانج(ب)   اخمن(افل

 ریھگو یک ومثن ےہ۔-5

ار(د)ایٹمری   (ج)  ایٹمرن(ب)   ایپری(افل ی

ٹ

 ُم

 ۔ ںی ابت رحتری رک ا وج رصتخم  ےک  ں  اول  وس

 اکی اسمرف رھگ یک ایک زیچ رلی ےک ڈےب ںیم ےل آای اھت؟ 

 الپوٹن امکڈنر ےنوجان ےس ایک اہکَ؟ 

 واصف دیپا رکات ےہ؟  لیھک اکی الھکڑی ںیم ایک ا

 ور وچڑایئ ینتک ےہ؟  اہیک ےک دیمان یک ابملیئ ا

 الل نیسح ےن وچیک رپ چنہپ رک ایک ایک؟ 

ل ربمن  ینم آڈر یک دشمگیگ یک دروخاتس رحتری رکںی۔ : 3وسا
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